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Chapter 6 
Piping Systems 

With AutoCAD MEP you can easily design and document Pipe Systems for both Pressure and 
Gravity applications. We will cover the fundamentals on how piping works in AutoCAD MEP, 
describe the settings that control piping, and discuss the preferred workflow approaches when 
laying out piping in both Pressure and Gravity systems. 

Introduction 

In this chapter we will look at how Piping works in AutoCAD MEP. We will explore what you 
need to know about creating a new system definition for your piping system, defining the fittings 
that will be used in the layouts, how pipe systems are displayed, and how the routing tools work 
when you are laying out your piping system. Routing tools incorporated into the PipeAdd 
command support sloped piping and true male x female connections. We will go through the best 
practices on how to lay out both pressure and gravity piping systems and the differences between 
them.  

Objectives 
In this chapter you will create new system definitions and lay out a fire protection 
system. We will create a sanitary piping system using the Sloped Piping abilities of 
AutoCAD MEP. By creating these systems, you will understand the fundamentals of 
routing, systems and routing preferences. Display configurations and how to control 
them will be explained and put into practice, and you will learn when to apply display 
overrides to create the desired look in construction documents. In this chapter you will: 

• Learn the fundamentals of Piping in AutoCAD MEP 

• Learn about Settings and Controls 

• Determine what fittings are used and when 

• Explore System Definitions 

• Learn about Pressure Piping System design tools 

• Learn about Gravity Piping System design tools 

Fundamentals of 3D Piping 
Let’s begin with an exploration of the fundamentals of 3D piping by reviewing what makes piping work. 
3D piping has certain characteristics, features, and settings that allow AutoCAD MEP to be an efficient 
3D piping application. Like other 3D layout features such as duct and cable tray, piping uses system 
definitions to determine which settings the pipe run will inherit. These include layers, display settings, 
system abbreviations, etc.  

Piping requires content such as elbows, pipes, tees, etc. to assemble a pipe run. These fittings are brought 
into the drawing from the pipe catalogs (see Chapter 11 for more information on creating fittings). Unlike 
duct and cable tray, the pipe feature leverages a style-based approach for storing the fitting preferences 
that will be used while creating a pipe run. This style is called a “Pipe Part Routing Preference,” more 
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commonly known as simply a “Routing Preference.” A Routing Preference is a collection of fittings 
stored inside a style that assigns different fittings based on the size of the pipe. These fittings are 
automatically loaded into the drawing file and added to the pipe run. Multiple styles can be created based 
on your needs, see the “Creating a Routing Preference” topic below for more information. 

Creating pipe runs leverages the auto routing functionality built into AutoCAD MEP for routed 3D 
objects to automatically add fittings and required connections within the run. Piping, like the other 3D 
layout objects, leverages the AecbCompass to restrict your cursor to the predefined angles stored within 
the AecbCompass dialog. This functionality allows for gravity (sloped) pipe runs to be designed using the 
fundamentals of real world piping by incorporating Angle of Deflection inside female pipe connections. 
See the “Auto Routing” topic below for more information. 

The ability to display piping is unique to all the 3D layout objects in AutoCAD MEP. Piping gives you 
the ability to show pipe runs with three different displays within the plan display representation based on 
diameter for each system definition. What this means is that you can display a single system as Graphical 
one line, Single Line and as a two line pipe solely based on the diameter specified in each system 
definition. See the “Understanding System Definitions” topic below for more information. 

As noted, System Definitions, Routing Preferences, and Display are all explained in more detail in the 
tutorials later in the chapter. However, the fundamental feature that leverages all of these controls and 
settings is the “Auto Routing” feature, which the next topic details. Routing preferences, the pipe fittings 
in the catalog and the AecbCompass directly impact the results of auto routing. Some items have been 
briefly explained, but you must understand their importance to auto routing before understanding how to 
create or configure the settings. 

Auto Routing 
AutoCAD MEP creates piping layouts using auto routing algorithms for the two different types of 
layouts; unconstrained and constrained. The unconstrained solutions are based on the angles you select 
when picking the points inside the drawing. AutoCAD MEP provides the AecbCompass during layout to 
limit the angles. Constrained layout solutions are determined by the fittings themselves and associated 
angles they support that are listed inside the current Routing Preference style to determine layout options 
and make connections. These two types of auto routing behaviors—unconstrained and constrained—react 
in different ways. Unconstrained applies when you are drawing pipe and you are not attempting to 
connect to another pipe or fitting. The unconstrained auto routing will adhere to the displayed angle on 
the AecbCompass (whether the routing preference supports the angle or not) as shown in Figure 6.1, 
while the constrained solutions use the angles from the content specified in the current routing preference. 
In the figure, the pipe is drawn to 45° since the third point picked was at 45°.  

  
Figure 6.1 

Unconstrained Pipe Routing (Auto Layout) 
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Tip: AecbCompass can be best described as Orthomode for AutoCAD MEP.  

With Orthomode on in AutoCAD, you are restricted to 90°, but with AecbCompass, you are restricted 
only to the angles you specify in the dialog. To access the AecbCompass, go to the View tab of the 
ribbon, on the MEP View panel, click the Compass button (see Figure 6.2). 

 
Figure 6.2 

Accessing AecbCompass 

In the “Compass Settings” dialog you can specify the diameter of the compass, the color, the snap angles, 
and the angle in which the tick marks appear (see Figure 6.3). 

 
Figure 6.3 

The Compass Settings Dialog allows you to configure your preferences for the 
Compass 

The Snap Increment can be set to any angle, but you should set this angle to the most common angle 
available. For example, Figure 6.3 shows a manually typed in value of 11.25. To input such a value, 
simply type over the existing value. The drop-down list shows all angles that have been typed in. To 
delete one, you simply select the angle and then press the DELETE key (see Figure 6.4). 

 
Figure 6.4 

Adding or deleting Compass Snap Increments in the drop-down list 



Page | 4 Copyright © 2010 – Cengage Learning All rights reserved. Do not reproduce without permission 

 

You can change the tick marks in the same manner as the snap increments. These settings are stored per 
user on the computer and are not stored in the drawings. We will cover the different ways to use the 
compass in the “Equipment and Piping Layout” and “Gravity Piping Fundamentals” topics later on in the 
chapter. 

When the Compass is turned on, it will display the snap angle increments before selection, and will 
display the available elbow/tee/lateral angles at each fitting during constrained layouts. In addition to the 
angle numbers, the Compass will also display the slope angle being proposed within each solution along 
the pipe segment. Figure 6.6 below shows the slope value on the pipe segment. It is displayed at one-half 
the text size of the angle. This allows you to determine the preferred slope value when laying out gravity 
piping. To turn this text on or off type PIPESLOPEDISPLAY at the command line. This command is only 
available via the command line. While you can turn it off, it is extremely useful when laying out gravity 
systems in constrained routing. It is therefore recommended that you leave it on. 

Auto routing constrained layout applies when you are drawing pipe and you try to connect to another 
pipe, fitting, or a Multi-View Part (commonly referred to as an Mvpart) (see Figure 6.5). During the 
constrained layout, you will get to preview the different connection options based on the available angles 
within the fittings stored inside the routing preferences (this will ignore the Compass angles specified). 
The command line will indicate how many possible solutions are available based on the available angles 
and fittings from your Routing Preference. You can change the preview of the possible solutions before 
accepting the one you prefer via the command line (see Figure 6.6) or the right click menu. 

  

Figure 6.5 
Constrained Pipe Routing (Auto Layout) Selecting connection point 

The Figures show the Slip On Flange 150 lb. and Threaded Routing Preference with 4" size selected. As 
you can see in Figure 6.6, there are three possible solutions, two with 90-degree elbows at different 
locations and 1 with a 45-degree elbow. The elbow in the Routing Preference supports both 45- and 90-
degree angles; therefore, both are used when calculating possible solutions. 
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Figure 6.6 

Three Possible Solutions with Slip On Flange Routing Preference 

The Auto Layout feature will create piping solutions based on parts stored in the Routing Preference and 
will add all required fittings and even change elevation as needed. This works by creating a plane based 
on the initial pipe’s location and another Plane at the connecting pipe’s location. The software will then 
calculate possible routes based on the available elbow angles stored within the Routing Preference or 
current elbow. When auto layout generates a layout, it can only generate options using up to four fittings; 
one on each end and two in the middle of the proposed layout. In addition, couplings that support 
deflection will also be considered when determining valid layouts. We will be covering this more in detail 
later in the chapter in the “Gravity Piping Fundamentals” topic. 

All pipe connections are aware of their gender (Male or Female) based on the Connector Engagement 
Length (CEL) value specified inside the pipe catalog. This value specifies whether the connection is 
inserted into another connection (male) or will allow another object to be inserted (female). This applies 
to all pipe connections on segments, fittings, and Multi-view Parts (MvParts). Please refer to Chapter 11 
for more information and to learn how this value is defined. In addition to defining the gender p on the 
CEL value specified in the pipe content, another parameter called AoD (Angle of Deflection) is available 
to specify the allowable angle of deflection within female pipe connections. The parameter and the value 
determine whether a female pipe connection can deflect. (AoD is also known as Fitting Tolerance.) 

The Angle of Deflection (AoD) is only allowed when the Connector Engagement Length (CEL) is greater 
than zero. This approach is based on how installed pipe runs are actually deflected during installation; 
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specifically, the female connection always controls whether joint deflection is allowed. In Figure 6.7, a 
Bell x Spigot elbow is connected on the bell end to a pipe.  

 
Figure 6.7 

Angle of Deflection defined on a Bell Connection Type 

The connection is not at zero degrees as indicated by each object’s center line. The connection is a valid 
connection since the bell connection (shown in the “Connection Details” dialog) has a specified Max 
tolerance angle (AoD) of 3.00° and the connection is currently using a tolerance angle of 2.64°. The Max 
tolerance angle is referring to the specified AoD parameter value inside the pipe catalog content fitting 
information. (See Chapter 10 for more information on accessing content.) To access the connection 
details for a pipe object, select the object, go to the Properties palette and beneath the Advanced grouping, 
click the Connection details worksheet icon (see Figure 6.8). 

 
Figure 6.8 

Accessing Connection details 

Within the “Connection Details” dialog you can see the connection type for each connector, the Max 
tolerance angle (AoD) for each connection, and location coordinates for each connection as well as flow 
direction. This is an easier way to determine if a connection allows deflection and the maximum value. 
See the “Gravity Piping Fundamentals” topic later on in the chapter for more information on AoD and 
controlling fitting tolerances. 
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Pipe Connections 
AutoCAD MEP can apply several different behaviors depending on what connection type is defined in 
the Routing Preference. The basic behaviors are as follows and shown in Figure 6.9: 

• Male to Male Connection Types: Butt Welded and Fusion 

• Male to Female Connection Types: Glued, Mechanical Joint, Socket Weld, and 
Threaded 

• Male to Female to Male (Joint Required) Connection Types: Grooved and No Hub 

• Flanged Connections are treated as a unique connection type in the software as in 
the real world; two Flange Faces are needed to make a connection. 

 
Figure 6.9 

Pipe Connection Behaviors 

*Existing connection types are defined as both female and male to support existing drawings. 

**Flanged to Flanged indicates both the face of flange and the connection type on the opposite 
connection such as slip on or threaded. 

***Grooved and No Hub always require a female connection between the male connectors. 

Note: Refer to the “Gravity Piping Fundamentals” topic below to learn how to route Male x 
Female Piping. 

The different connection types have unique rules associated with them. AutoCAD MEP requires that all 
Pipe Connectors are defined as either Male or Female in the Content file and applies rules based on this 
information. Please refer to Chapter 11 for more information on how to build fittings.  

All connection types requiring a joint will be added automatically based on the joint type specified in the 
Routing Preference. Automatic joints are not necessary for Butt Welded and Flanged connections; 
however these may be added as needed. When a fitting to fitting connection is attempted, AutoCAD MEP 
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will read the connection type, determine if it is male or female, and then determine if an additional object 
is required. For example, when you attempt to draw a fitting to fitting connection with the Glued Routing 
Preference, the connection on the elbow is determined to be female and a pipe segment will automatically 
be added making a female to male to female connection. When a Grooved connection is made, the female 
joint will be added between the 2 male connections making a male to female to male connection as shown 
in Figure 6.9. 

Flanged connections are allowed to have the face of a flange connect to another face of flange and will 
add additional flanges (Joint Connection) as necessary to complete the connection. When a fitting to pipe 
connection is made, the pipe will have a flange added to the end of it to match up with the flanged 
connector built within the elbow. Two flanges will be added when adding a joint connection in a pipe 
segment. When two flanged fittings meet, no additional flanges will be added between the two fittings. 

The Butt Welded Connection is defined in the software as a special connection type that is allowed to 
connect to itself without an additional joint object. Therefore, if the fittings specified in the routing 
preference have the connection type defined as Butt Welded and the joint type is defined as another 
connection type, such as grooved, the fitting to fitting connection or fitting to segment will be allowed to 
connect to one another without adding the specified joint object.  

Understanding a Routing Preference 
Piping systems are created by accessing the Fittings stored inside the Pipe Catalogs supplied with 
AutoCAD MEP and specified in Pipe Part Routing Preferences (also referred to as simply “Routing 
Preference”). A Pipe Part Routing Preference is a style that includes a collection of fitting types. Like 
other styles, they are accessed through Style Manager (see Figure 6.10). The list of catalog fittings in the 
Routing Preference allows AutoCAD MEP to assemble a pipe system as it would be assembled during 
construction. We will begin by explaining what a Pipe Part Routing Preference is and how it is utilized 
when adding pipe. 

 
Figure 6.10 

Style Manager Button on the Manage ribbon tab 

You can open the Style Manager from the Manage ribbon tab on the Style & Display panel. On the left 
panel expand Piping Objects and then expand Pipe Part Routing Preference. All of the Routing 
Preference styles will appear both in the expanded list on the left side and on the right panel (see Figure 
6.11). 
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Figure 6.11 

View available Pipe Part Routing Preferences in the Style Manager 

A Pipe Part Routing Preference is defined based on Size Ranges. Size Ranges allow you to specify 
different fittings based on the lower and upper limit within a size range. Each Pipe Part Routing 
Preference can have multiple size ranges. 

Within each size range you can specify the type of Joints, Crosses, Elbows, Pipes, Takeoffs, Tees, Wyes 
(Laterals) and both Concentric and Eccentric Reducers. The parts listed are stored in the Part Catalogs 
that are supplied with AutoCAD MEP. We will cover more about content below. 

In Style Manager, you can view the settings of any Routing Preference definition. On the Preferences tab, 
one or more size ranges are listed with labels like “Size Range 1” or “Size Range 2.” Each size range has 
a description. This description appears in the Size drop-down list on the Properties palette when adding 
pipe. The “Size Upper Limit” setting appears next and is used two ways. The drop-down list contains the 
available common sizes for the selected parts. When selecting parts that change the upper limit or the 
available sizes, a warning dialog will appear stating that the Size Range will be changed. The Size Upper 
Limit can also be used to set the preferred size that you want to use as the upper limit, which in turn sets 
the lower limit in the next size range. 

The type column specifies the types of fittings that are allowed to be stored in a Routing Preference and 
the Part Size Range Column specifies the minimum and maximum sizes available for the selected fitting.  

Install the Dataset Files and Open a Project 
The lessons that follow require the dataset included on the Aubin Academy Mastering Series online 
companion. If you have already installed all of the files from this site, skip to step 3 to begin. If you need 
to install the files, start at step 1. 

1. If you have not already done so, download the dataset files located on the 
CengageBrain website. 

Refer to “Accessing the Student Companion site from CengageBrain” in the 
Preface for information on installing the dataset files included in the 
Student Companion. 

2. On the Quick Access Toolbar (QAT), click the Project Browser icon  
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3. Click to open the folder list and choose your C: drive. 

4. Double-click on the MasterMEP 2011 folder. 

5. Double-click MAMEP Commercial to load the project. (You can also right-click on it 
and choose Set Project Current.) Then click Close in the Project Browser. 

Important: If a message appears asking you to repath the project, click Repath the project 
now. Refer to the “Repathing Projects” heading in the Preface for more 
information. 

Set up the Piping Workspace 
We will begin with creating a Routing Preference and a System Definition for the Fire Protection system. 
Make sure that the Piping Workspace is active and that the Tool Palettes are displayed (see Figure 6.12).  

Refer to the “Choosing your Workspace” topic in the Quick Start chapter if you are not sure how to load a 
Workspace and refer to the “Understanding Tool Palettes” topic in Chapter 1 for information on how to 
load and work with tool palettes. 

 
Figure 6.12 

Enabling the Piping Workspace 

Load a Catalog 
Provided with the files installed from the Mastering AutoCAD MEP CD ROM is a catalog containing 
some of the piping items used in the following tutorials. Before we begin the lessons, let’s take a moment 
to load the required catalog.  

6. From the Application menu, choose Options.  

7. In the “Options” dialog, click the MEP Catalogs tab. 

8. In the Catalogs area, select the Pipe folder. 

9. Click the Add button. 

10. Browse to the C:\MasterMEP 2011\MAMEP Pipe folder, select the MAMEP Steel 
Pipes.apc and then click Open. 

The MAMEP Steel Pipes catalog contains the updated Grooved Flanged 
Adapter required for the lessons below.  

11. Use the Move Up button on the right to make the new catalog the first in the list and 
then click OK to exit the “Options” dialog (see Figure 6.13).  
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Figure 6.13 

Add a custom catalog to your list and move it to the top 

After loading a new catalog, you must regenerate the catalogs to update the change.  

12. On the Manage Tab, expand the MEP Content panel and click the Regenerate 
Catalog button (see Figure 6.14).  

 
Figure 6.14 

Regenerating the AutoCAD MEP Catalog 

13. On the command line select Pipe (type P), click OK to confirm any messages that 
appear, and then press ENTER at the command line to finish. 

Create a Routing Preference 
In this exercise, we will be creating a new Routing Preference for the sprinkler system piping.  

1. On the Project Navigator palette, click the Constructs tab. 

2. Under Constructs, expand the Fire Protection folder and then double-click to open 
the 01 Fire Protection drawing. 

3. On the Manage tab, on the Style & Display panel, click the Style Manager button. 

4. Expand the Piping Objects folder. 

5. Select the Pipe Part Routing Preferences item and on the toolbar at the top, click 
the New Style icon (see Figure 6.15). 
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Figure 6.15 

Creating a new Routing Preference 

6. Type “Cast Iron Threaded and Steel Grooved” for the name in the left panel. 
The General Tab allows you to edit the name or add a description. We will not make any such edits at this 
time. On the preferences tab we will begin selecting the fittings to use for this routing preference. 

7. On the right side, click the Preferences tab.  

Size Range 1 will appear automatically.  

8. For the Description, type Cast Iron Threaded. 

For now we will accept the default for Upper Size Limit and make no changes to it. Next to each 
condition *None* is currently selected. Click on *None* to open a pop-up list of available choices. 

9. Next to Joints click on *None* to open a pop-up menu.  

10. Scroll down to the Cast Iron Pipe (US Imperial) catalog and then select the 
Threaded – Class 3000 - Forged Coupling item (see Figure 6.16).  

A message will appear warning you that your selection will change the Size 
Upper Limit.  

11. In the warning dialog, click Yes. 
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Figure 6.16 

Selecting a Fitting 

Cad Manager Note: AutoCAD MEP Catalogs are separated by material type. The order of the catalogs can be 
modified in the “Options” dialog. From the Application menu, choose Options and then click on the MEP Catalogs tab. 
The order of the catalogs as listed determines the order of the catalogs in any of the commands that access the 
catalogs. 

12. Repeat the process to assign the following parts from the Cast Iron (US Imperial) 
Catalog (see Figure 6.17): 

• Cross—Threaded – Class 3000 – Forged Cross. 

• Elbow—Threaded – Class 3000 – Forged Elbow. 

• Flex Pipe—No change (Leave this at *NONE*).  
Note: You are not required to specify all parts in a routing preference. If the part is 

needed while adding pipe, a dialog will appear asking that you select the 
appropriate part. 

• Lateral—No change (Leave this at *NONE*). 
For the Pipe setting, we’ll access a different Catalog.  

• Pipe—Select Commercial Pipe in from whatever catalog it is listed. See note. 
Note: The Commercial Pipe can be used for all materials and types. This pipe segment 

has all available sizes and allows for more sizes to be listed in the Routing 
Preference. In previous releases, the Commercial Pipe segment replaced most 
material-based segments since they all shared common dimensions. In current 
releases of AutoCAD MEP, the pipe catalog is now broken out to multiple catalogs 
based on material, so each of these catalogs has a copy of this pipe segment to 
support drawings created in previous releases. AutoCAD MEP will display the first 
instance of duplicate content (pipes and fittings) based on the order of the 
catalogs. 
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The remaining settings will come from the Cast Iron (US Imperial) Catalog 
again. 

• Takeoff—Threaded – Class 3000 – Outlet. 

• Tee—Threaded – Class 3000 – Forged Tee. 

• Transition - Concentric—Threaded – Class 3000 – Reducer. 

• Transition - Eccentric—No change (Leave this at *NONE*). 

 
Figure 6.17 

The completed settings for Size Range 1 of the Cast Iron Threaded style 

Size Range 1 is now complete. We are going to add an additional size range for the Grooved portion of 
the Routing Preference. 

13. Click the Add Size Range Button at the bottom of the dialog. 

14. For the Description, type Grooved Flexible Coupling – Steel (see Figure 6.18). 

 
Figure 6.18 

Input a description 

15. Assign the following parts from the Steel Pipe (US Imperial) Catalog (see Figure 
6.19): 

• Joints—Grooved – Flexible Coupling 0.75-12 Inch. 
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• Cross—Grooved – Cross. 

• Elbow—Grooved – Elbow. 

• Flex Pipe—No change (Leave this at *NONE*).  

• Lateral—Grooved – 45 Deg Lateral. 

• Pipe—Steel Pipe. 

• Takeoff—Butt Welded - Outlet. 

• Tee—Grooved - Tee. 

• Transition - Concentric—Grooved – Concentric Reducer. 

• Transition - Eccentric—Grooved – Eccentric Reducer. 

 
Figure 6.19 

Completed settings for Size Range 2 – Grooved  

16. Click OK to exit Style Manager. 
We have now created the Routing Preference for the Fire Protection system. Let’s test it out to make sure 
it is working properly. 

17. On the Home tab of the ribbon, on the Build panel, click the Pipe button. 

18. On the Properties palette set the Routing Preference to: Cast Iron Threaded and 
Steel Grooved. 

19. Set the Nominal size to 2" and then draw a small pipe run on screen. 

Make a few 90-degree turns to trigger the insertion of fittings (see Figure 
6.20). 

20. Press ENTER to complete the command.  
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Figure 6.20 

Draw a short pipe run to check the Routing Preference 

21. Start the PipeAdd command again, change the Nominal Size to 6" and draw 
another run to check the Grooved Size Range. 

22. Press ENTER to complete the command.  

23. Erase the pipes and fittings.  

It is possible to undo here, but be careful you do not go too far and undo the creation of the Routing 
Preference style.  

Understanding System Definitions 
Now that the Routing Preference is defined for the Fire Protection system, we need to create a System 
Definition for the sprinkler system. System Definitions assign the Layer Keys, Display System settings, 
Abbreviations, System Grouping, Rise Drop styles and determine if the piping and equipment assigned to 
the system will display as single line, graphical single line, or two line. In addition, System Definitions 
determine whether items assigned to this system will follow the display system drawing default or will be 
assigned a system level override. 

System definitions are used to separate objects based on their use such as a fire protection system versus a 
chilled water system. This allows you the flexibility to isolate the systems as well as assign uniquely 
different characteristics to the objects designated to this system such as layer, abbreviation, and display 
properties.  

Creating a System Definition 
1. On the Manage tab, on the Style & Display panel, click the Style Manager button. 

2. Expand the Piping Objects folder. 

3. Select the Pipe System Definitions item and, on the toolbar at the top, click the New 
Style icon (see Figure 6.15). 

4. Type Sprinkler System for the name. 
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With the new style selected in the left pane, you will be able to edit it on the 
right. As with all style, the General Tab allows you to edit the name and/or 
add a description (see Figure 6.21). 

 
Figure 6.21 

Creating a new Pipe System Definition 

CAD Manager: Routing Preferences, System Definitions and other kinds of styles can be stored in template files 
(DWT). This means that each new drawing created from the template will have those items already available. You 
can also create tool palettes to import systems, routing preferences and preferred settings as needed on a per 
drawing basis. For more information please refer to the online help. 

Configure the Style Settings 
On the Design Rules tab you assign an Abbreviation, System group and the associated Layer Key to the 
system.  

5. Click the Design Rules tab. 

6. In Abbreviation field, type SPKR. 

7. From the System Group drop-down choose Non-Potable Water. 
8. From the Layer Key drop-down choose F-SY-PIPE-WET_PIPE_SUPPLY (see 

Figure 6.22). 

The abbreviation is used with some labels and is also appended to the end of the System Name within the 
Properties Palette.  

The System Group allows all System Definitions that have the same group to connect to one another. For 
example, all the Chilled Water systems and our new Sprinkler System have the same Non-Potable Water 
System Group, which allows these systems to connect to the same pipe main coming into the building, 
enabling AutoCAD MEP to determine which System Definitions are allowed to cross connect. The 
AutoCAD MEP Default systems are set up with basic System Groups. 
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Figure 6.22 

Design Rules allow us to configure the Abbreviation, System Group and Layer 
settings 

Note: The System Group is not a fixed list. To add a new system group to a drawing, 
simply type the new System Group Name into the drop-down list field. To have a 
custom system group available in all new Drawings, add the System Group to your 
company’s drawing template file DWT. When no system group is assigned, the 
system will be allowed to connect to any System. This is beneficial for systems like 
Drain. 

A Layer Key automatically creates and assigns layers for objects based on a standard list. For more 
information on Layer Key Styles refer to the online help. 

The Rise and Drop Tab stores which Rise and Drop style will be used for this System. 

9. On the Rise and Drop tab, choose the Pipe Break – Patterned Rise Only style 
(see Figure 6.23). 

 
 

Figure 6.23 
Setting the Pipe Rise and Drop Style 

Note: For more information on how Rise Drop Styles work please refer to Appendix A. 

10. AutoCAD MEP allows pipe systems to display in graphical single line, to-scale 
single line, or as two line display, and is controlled by the Single Line Graphics tab. 

11. Click on the Single Line Graphics tab. 
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12. Select the two checkboxes to enable single line and graphical 1 line display. 

• For the single line displays, set the “For pipe size less than or equal to” to: 4". 

• For the graphical 1 line, set the “For pipe size less than or equal to” to: 3". 

Set the “Inline/anchored MvPart plot length” to 1/8" (see Figure 6.24). 

  
Figure 6.24 

Configure the settings for Single Line Graphics 

This will display pipe as single line display when the size is equal to or under 4". This allows piping with 
diameters above 4" to display as two line. The intent of 1 line display is to show the piping, inline, and 
anchored components symbolically, while still representing some of the key spatial factors of the piping 
and components (see Figure 6.25). 

 
Figure 6.25 

Graphical 1 Line, Single Line Piping and 2 Line Piping Display characteristics 
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When Single Line Graphics are being used, (whether Single Line or Graphical 1 Line), the display of 
inline equipment such as Valves will use the symbolic version of the equipment.  

Pipe Single Line graphics styles are controlled by the Pipe Single Line Graphics Styles. To change the 
display of the symbol used for the connection type go to Style manager, Piping Objects, Pipe Single Line 
Graphics Styles (see Figure 6.26). 

 
Figure 6.26 

Pipe Single Line Graphics Styles 

Pipe Single Line Graphics Styles use AutoCAD blocks to represent the connection graphic on pipe 
connectors. You can create your own AutoCAD Blocks to represent connection types. 

When creating blocks for Pipe Single Line Graphics, the block size should be based on 1 unit high by up 
to 1 unit wide (see Figure 6.27). 

 
Figure 6.27 

Pipe Single Line Graphics Style Block Rules 
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Pipe Single Line Graphics Styles allow you to create multiple styles and assign them on a per system 
basis. This allows you to determine what the single line connection graphic is based on its use. For 
example, existing or piping to be demolished can have no connection graphics display to simplify the 
display of your drawings. The Single Line Graphics Style for a system is defined on the Single Line 
Graphics style for that system (See Figure 6.26).  

Display Properties 
The basics of the Display System have been covered in detail already in previous chapters. When you 
configure a style, such as the System Definition in consideration here, you have the option to assign style-
level display properties to it. Settings on the Display Properties tab are used to control the appearance of 
the style (in this case the System Definition). Before making any edits to the display properties of the 
System Definition, make sure you are comfortable with the display system hierarchy and definitions. 
Refer to the “Overview and Key Display System Features” heading in Chapter 2 and the “Display 
Properties and Definitions” topic in Chapter 12 for definitions of the key Display Control terms. You will 
also find detailed tutorials on working with the Display System in Chapter 12. 

Configure Display Properties 
1. Click the Display Properties tab. 

Notice that there are several Display Representations listed. In this exercise we will focus on the Plan 
Display Representation. The other Display Representations are discussed as appropriate in other chapters. 
For the Fire Protection Sprinkler System Definition that we are building here, we want to turn on the 
Centerline display component for this system. Therefore we will need to add a System Definition 
override. 

2. Next to plan, in the Style Override column, check the box to add the override (see 
Figure 6.28). 

 
Figure 6.28 

Applying a Style Override to Plan 

The “Display Properties” Dialog will appear. The titlebar will read: “(Pipe System Definition Override – 
Sprinkler System) – Plan”. This indicates that a System Definition level override is now applied.  

3. Select the Center Line Display Component and then click the Light Bulb icon next 
to it to turn on its visibility (see Figure 6.29). 
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Figure 6.29 

Turn on the Center Line component 

4. Click OK to dismiss the “Display Properties” dialog.  

5. Click OK again to dismiss the Style Manager and complete the System Definition 
setup.  

The setup is now complete and we are ready to begin laying out our equipment and piping.  

6. Save the drawing.  

Equipment and Piping Layout 
In general, layouts begin with determining the equipment location to allow others involved with the 
design to review access requirements, structural issues and additional information critical for making an 
informed decision. 
 
The Equipment command on the ribbon allows you to add equipment (Multi-view parts) from the 
AutoCAD MEP catalog. The catalog contains equipment that is modeled three-dimensionally at actual 
size and has specific information such as dimensions, required or optional connections and 1 line 
symbols.  

Adding Equipment 
When you click the Equipment button on the ribbon, it calls the MvPartAdd command. The MvPartAdd 
command opens the Multi-view Parts (MvParts) dialog which allows you to find specific equipment 
through the catalog’s folder structure (see Figure 6.30). 
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Figure 6.30 

Adding Equipment starts the MvParts command 

By expanding folders you can find parts listed in broad categories. Once you have selected a piece of 
equipment, you can click the Part Filter tab which allows you filter the list of parts based on specific 
criteria. MvParts can be defined as either block-based or parametric-based content, and is identified by 
different icons within the dialog. Refer to Chapter 9 for more information. 

 
Figure 6.31 

Filtering Equipment via MvPartAdd 

On the Part Filter Tab the top left panel includes many Filter Controls (see number 1 in Figure 6.31). 
Once you begin assigning filters, the parts found quantity begins to reduce (see number 2 in Figure 6.31). 
Some parts have the capability to create thousands of options, so using the filter allows you to focus your 
selection. You can filter the selection set using the Catalog Entries such as: 

• Connections (Details such as Diameter) 

• Display 

• Part Size Name 
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In addition, the Details list (see number 3 in Figure 6.31) also allows you to select a part based on the 
parameters from the part catalog. The information here shows the visible parameters in the content builder 
part parameters. If you want to display the non-visible parameters, you can select the “Display/Hide 
additional part parameters” check box at the bottom of the details drop list. To access and change the 
visibility of a parameter you will need to edit the part in the content builder and edit the part’s parameters 
by accessing the parameter configuration dialog. To find out how to do this, please refer to Chapters 9 and 
10. 

Multi view Parts are style-based objects that display an AutoCAD block for each view. This allows the 
Multi-View Parts to display differently depending on which way it is being viewed. To access the list of 
AutoCAD blocks being used for each view, select an instance of the Multi-view part in your drawing, go 
to the Ribbon and select Edit Style then select the View tab (see Figure 6.32). 

Each numbered symbol at the top of the dialog refers to a unique view inside AutoCAD MEP. To view 
the block name associated with the view, simply select the view in the top section and the settings section 
updates (see Figure 6.32). 

 
Figure 6.32 

Accessing Multi-View Part Styles and View Blocks 

Note: Editing the blocks or changing the blocks will only affect this drawing. All blocks are created from 
the catalog. Refer to Chapter 10 for more information on creating equipment. 

Create a Fire Protection System 
Now that we have completed configuring the necessary settings, (we created a Routing Preference, a 
System Definition and explored the basics of adding equipment) we are ready to begin the layout of a fire 
protection system. For this exercise, we will work on the first floor of our commercial project.  

Adding the Fire Pump 
The first step in laying out your system is to lay out a pump, the associated suction and discharge, and the 
required valves. 

Continue in the 01 Fire Protection drawing (in the Fire Protection folder of 
Project Navigator). 
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1. Zoom in on the room in the upper right corner of the first floor plan. 

2. On the Home tab, on the Build panel, click the Equipment drop-down and then 
select the Pump Control (see Figure 6.33).  

This filters the “Add Multi-view Parts” dialog to show only Pump Equipment. 

 
Figure 6.33 

Adding Equipment using with one of the tools automatically filters the Add Multi-
view Parts command 

In the “Add Multi-view Parts” dialog, Base Mounted Pumps US Imperial is selected. This is the pump we 
are going to insert, but before we do, we want to change the size and elevation. 

3. From the “Part Size Name” list, choose 4x4 Inch Base Mounted Pump (see 
Figure 6.34). 

4. To allow a slab to be added below the pump, change the Elevation to 6".  

 
Figure 6.34 

Selecting the Fire Protection Pump 

Do not click Close in the “Add Multi-view Parts” dialog.  

5. In the drawing window, click to place the pump on the right side of the Fire 
Protection room with the motor pointing towards the exterior wall approximately in 
the position shown in Figure 6.35. 
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Figure 6.35 
Adding Fire Protection Pump to Room  

6. Click Close to dismiss the “Add Multi-view Parts” dialog. 

Fire Pump Supply Piping 
Note: For this exercise we are going to assume the supply pipe, for the Fire Protection 

system is coming from the upper left-hand corner of the room and the discharge 
will be in the lower left-hand corner of the room. We will not be adding the entire 
water supply in this exercise, just the specific piping in and around the pump; we 
will lay out the sprinkler heads and associated piping in a later exercise. 

7. Select the pump you just placed. 

8.  On the Equipment Tab of the Ribbon, click the Equipment Properties button.  

9. In the “Multi-view Part Properties” dialog, click the Systems tab, set the Inlet and 
Outlet Systems to Sprinkler System, and then click OK (see Figure 6.36). 

 
Figure 6.36 

Configure the Connector Systems for the Multi-view Part 
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Now that we have the pump placed and its connectors configured, let’s copy it to the left to create a 
primary and backup pump system.  

10. With the pump still selected, on the Home tab, on the Modify panel, click the copy 
button.  

11. Click any basepoint, move the cursor to the left (make sure ortho is on with the F8 
key), type 4'-0", and then press ENTER. Press ENTER again to complete the 
command (see Figure 6.37). 

 
Figure 6.37 

Copy the pump to the left 

12. Select the pump on the right and then click the Add Pipe grip (+) on the suction 
side of the pump (the bottom Add Pipe grip).  

The “plus” grip starts the “Add” command associated with the connection type as defined in the part 
catalog. In this instance the connection type is defined as a Pipe connection and as the connection type 
Flanged, therefore the PipeAdd command is started and will require a flanged joint. Recall above in the 
“Create a Routing Preference” topic that we assigned joint types for various situations. In this case, 
however, we are going to temporarily override the Joint type in the Routing Preference with a Grooved – 
Class 150 – Flanged Adaptor 2-12 Inch from the Steel Pipe Catalog. We can do this using the Fitting 
Setting override capability.  

13. On the Properties palette, in the Advanced grouping, click on the Fitting Settings 
worksheet icon (see Figure 6.38). 
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Figure 6.38 

Selecting the Joint Connector Override 

14. In the “Fitting Settings” worksheet that appears, from the Joint Connector drop-
down list, under Steel Pipe (US Imperial), choose Grooved – Class 150 – Flanged 
Adaptor 2-12 Inch.  

This will be used for the Pipe connection at the pump. 

15. Move your cursor straight down so the compass reads 0.00° angle, type in 20 and 
then press ENTER.  

16. On the Properties palette, set Justify to Top Center (see Figure 6.39). 

17. Change the pipe Nominal size to 6"  

 
Figure 6.39 

Setting Justification during Pipe Layout 
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The “Choose a Part” Dialog will appear because the size change goes across Range 1 and 2; therefore you 
need to verify the part you want to use as shown in Figure 6.40. 

 
Figure 6.40 

You must verify your part choice when the size change spans more than one 
range 

18. In the “Choose a Part” dialog, select the Grooved – Flexible Coupling 0.75" to 12" 
and then click OK. 

19. Continue to drag your cursor in the same direction, type 30" (2'-6") and then press 
ENTER. 

This will add an Eccentric Reducer and pipe. 

20. Next, pick a point towards the left pump so an elbow is added (see Figure 6.41). 

 
Figure 6.41 

Suction Piping for Fire Protection Pump 

21. Press ENTER to exit the PipeAdd command. 

22. Select the suction piping coming from the Pump up to the elbow at the bottom of 
the screen. (See Figure 6.42 to see the copied pipe.) 

23. Copy the selection using the AutoCAD MEP snaps: For the base point, snap to the 
Pipe End Connector (PCON) snap point on the Discharge connection on the pump 
on the right, and then snap to the PCON on the discharge of the pump to the left.  
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This copies the 4" and 6" piping with fittings to the left pump.  

24. Select the 6" pipe, click the Plus (+) Grip. For the next point, select the end of the 
horizontal pipe using the PCON snap and cycle through the solutions by selecting 
Next from the right click menu. When the solution using a 90-degree elbow is 
shown, right click and select Accept (see Figure 6.42). 

25. Press ESC to complete the command. 

 
Figure 6.42 

Connecting the Second Pump to create the header piping 

26. Select the left 6" elbow. Click the left plus (+) grip to change the elbow into a tee 
(see Figure 6.43). 

 
Figure 6.43 

Upgrading an Elbow to a Tee 

Once the Tee is placed you can set the Bend angle on the Properties palette to 90°. This means that only 
90-degree elbows will be used in routing. Therefore, if you pick a point in the upper left corner of the 
room, a 90° bend and a pipe along the wall will be created instead of the “Choose a Part” dialog 
appearing and prompting for an odd angle. 
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Figure 6.44 

Locking the Bend Angle to control Auto Layout 

27. In the palette, set the bend angle to 90 (see Figure 6.44). 

28. Make sure ortho is off (F8), and then click a point near the corner of the room as 
shown in (see Figure 6.44). 

29. Change the elevation to -4'-0" to draw the pipe down below the slab, and pick a 
point outside the exterior wall to complete the suction piping. 

30. Press ESC to complete the pipe command. 
Later in the chapter we will be adding valves to these pipes, but for now this completes our work on the 
suction piping. Next we are going to lay out the discharge piping for the two pumps and combine them 
into a single discharge header. 

Fire Pump Discharge Piping 
13. Select the right pump and then click the discharge plus (+) grip.  

14. On the Properties palette, change the Justification to Center. Change the size to 
6",  

The “Choose a Part” dialog will appear to select a Flanged Reducer. 

15. Under Steel Pipe (US Imperial), select the Flanged – Class 150 – Reducer, and 
then click OK. 

16. On the Properties palette, set the Elevation to 6'-0". 

17. Select the Grooved Flanged Adapter 2 – 12 Inch in Choose a Part from the 
MAMEP Pipe catalog. 

18. Move the mouse down and to the right away from the pump at 45 degrees (towards 
the Suction Pipe) approximately 24" in length (by the elbow on the suction pipe), 
where the elbow is shown in Figure 6.45. 

19. Pick the next point straight down by the lower wall, and then another in the lower 
left corner of the room (see Figure 6.45). 
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Figure 6.45 

Laying out the Discharge Header 

20. Change the Elevation to 12'-0" and then press ENTER to exit the command. 

Changing the elevation has the effect of adding a vertical run of pipe at the current point. Later we can 
view the model in section or 3D to see this more clearly,  

21. Use a window crossing selection to select the riser from the pump discharge and all 
the piping up to and including the 45-degree elbow. Zoom in closely to avoid 
selecting components on the suction side of the pump.  

22. Using AutoCAD copy, snap the basepoint to the lower left corner of the pump using 
the insertion point osnap (INS) to correctly select the basepoint, and then copy the 
selection to the left pump, snapping to the same relative point, again, using the INS 
snap. 

23. Select the 45-degree elbow and then click the Plus (+) grip to start PipeAdd. 

24. Click a point on the horizontal pipe along the bottom wall (see Figure 6.46) to 
connect the discharge piping. 

 
Figure 6.46 

Connecting to the Discharge Header 

25. Select the solution that routes with no additional elbows by using the Next/Accept 
options on the command line and then exit the command. 
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26. Press ESC to end the pipe command. 
Note: Depending on the accuracy of the point you click relative to your desired angle, 

Auto Layout solutions may change the order using the coordinate of your selection 
point relative to your starting point as the driving factor on which solution appears 
first. 

That completes the work we will do on the discharge piping for now. We will be adding the rest of the 
sprinkler system piping later on in the chapter. 

Adding Valves to the Fire Pump Suction and Discharge Piping 
Next we will be adding the suction and discharge valves to the piping.  

1. On the Home tab, on the Build panel, click the Equipment drop-down button and 
choose the Valve tool. 

2. Expand the Valves folder and then select the Gate Valves US Imperial item.  
Note: You do not need to set the size—the system will select the correct size and 

connection type for you. 

Remember, do not close the “Add Multi-view Parts” dialog; simply click in 
the drawing to shift focus there. 

3. At the command line, type PCUR and then press ENTER.  

4. Click in the middle of the right pump’s 6" suction pipe.  

5. Type P and then press ENTER.  

This changes the plane of the compass to align to your view.  

6. Press ENTER again.  

The “Choose a Part” dialog will again appear asking for the appropriate 
flange to use.  

7. Expand the Steel Pipe Catalog. Scroll down and select the Grooved – Class 150 – 
Flanged Adaptor 2-12 Inch and then click OK (see Figure 6.47).  

 
Figure 6.47 

Choose a Part to select a Flange for the Gate Valve 

Note: If the valve comes in with the stem facing down, simply select the valve and then 
select the Flip Grip that appears next to the Valve to rotate 180 degrees. 
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8. Pick on the 6” pipe leading to the left pump’s suction end and repeat the process to 
add another valve (see Figure 6.48). 

 
Figure 6.48 

Placing the Suction shut off valves 

9. Repeat the process to add two more valves to the discharge piping. Place one right 
before the elbow (right pump) and the other right before the Tee (left pump) as 
shown in Figure 6.49. 

10. After placing the valve, select it, hold down the CTRL key, and click the flip grip to 
rotate the valve 90 degrees instead of 180 (see Figure 6.49). 

 
Figure 6.49 

Use the CTRL key to flip a valve 90° (the valve on the left is shown already 
flipped)  

Our next task is to add a check valve to the elbow coming out of the pump. We will use the Plane option 
again to orientate the valve to the correct plane.  

11. On the Home tab, use the Equipment drop-down to add another Valve. 

12. In the “Add Multi-view Parts” dialog, select the Check Valves US Imperial item.  

13. Click on the discharge pipe before the gate valve in the locations shown in Figure 
6.50. Use the mouse to indicate the rotation. (Remember you can always flip it with 
the grip later if necessary).  

14. In the “Choose a Part” dialog, select the Grooved Flanged adapter again. 
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Figure 6.50 

Completed Layout of Fire Protection Room 

Editing Pipe Layouts 
A major advantage of working with AEC objects is that you can manipulate them at any point in your 
project cycle instead of the more traditional erase and redraw methodology common in most firms today. 
Pipes, fittings, and other objects in your drawing know what they are and have built-in behaviors. They 
are able to maintain logical relationships to one another as manipulations are made. In this topic we will 
look at some of those built-in behaviors as we fine-tune our fire protection pump layout.  

Remove Unnecessary Pipes 
To fine-tune the layout, we are going to remove the unnecessary pipes between the valves using the 
“Associated Movement” ability in AutoCAD MEP, otherwise known as “StickyMove.” StickyMove 
allows you to edit AutoCAD MEP objects with the grips, while the system automatically adds and/or 
deletes objects as needed to keep the system connected. This powerful behavior is used on all 3D objects 
in AutoCAD MEP. To use StickyMove, you simply need to select an object, then select the rectangular 
move grip and drag it to the appropriate connector. AutoCAD MEP will take care of the rest.  

1. Select the Gate Valve on the Suction Piping for the Left Pump.  

2. Click the rectangular grip on the side opposite the pump. 

3. Drag the rectangular grip to the connector of the tee and snap using the PCON 
snap (see Figure 6.51). 

 
Figure 6.51 

Using Grips to edit layout 
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4. Repeat this process to move all the valves to the associated fittings (see Figure 
6.52). 

 
Figure 6.52 

Move valves to connect directly to fittings 

Next we’ll break the pipe between the Check valve and Gate valve to raise the header to 8'-0". 

5. On the Home tab, click on the Modify panel title.  

The panel will expand to reveal several additional standard AutoCAD 
drafting tools.  

6. Click the Break tool (see Figure 6.53).  

 
Figure 6.53 

Move valves to connect directly to fittings 

If you prefer, you can type BREAK at the command line (BR is the shortcut). 

7. At the “Select object” prompt, select the pipe between the Check valve and the 
Gate valve for the right pump. 

8. Move the mouse slightly and then click the second point of the break so that the 
pipe is in two parts (see Figure 6.54). 

9. Repeat for the left pump piping. 
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10. Select the broken pipe connected to the Gate valve. On the Properties palette 
change the elevation to 8'-0".  

All the horizontal piping and valves connected to this pipe will move to 8'-
0". To verify this, simply hover your cursor over the objects and the Tooltip 
will indicate the new elevation (see Figure 6.54). 

 
Figure 6.54 

Discharge piping moved to 8'-0" 

Now that the discharge piping has changed elevation we can connect the 
two pipes and add the associated elbows. 

11. Select the pipe connected to the Gate valve, click the plus (+) grip, and then click 
the PCON (PIPE END CONNECTOR) snap on the pipe connected to the Check valve.  

12. Multiple solutions will appear; please select number one as indicated in Figure 
6.55.  

  
Figure 6.55 

Auto layout finding multiple solutions 

13. Repeat the process for the other pump. 
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We have completed the Suction and Discharge of the pump run. We have learned how to create Routing 
Preferences, System Definitions, add equipment (pumps and valves), create pipe layouts, and edit the 
layouts using the Associated Movement (StickyMove) functionality. As you can see, AutoCAD MEP 
gives you many benefits, including the ability to create complex 3D layouts from a simple plan view and 
to make powerful edits quickly and easily with the StickyMove functionality. Let’s take a look at what we 
have accomplished in a 3D view. 

14. On the View ribbon, Appearance panel, choose View, NE Isometric from the View 
list. 

15. On the View ribbon, Visual Styles panel, choose Conceptual from the Visual Styles 
drop-down list. 

Note: the Home tab of the ribbon has a View panel that may be more 
convenient than switching to the View ribbon (see Chapter 1 for more 
details on the ribbon). You can also ‘tear off’ the View panel so it is floating 
and always available. 

16. Click and drag the ViewCube in the upper right corner of the screen to orbit the 
view to a steeper angle. (You can also hold down the SHIFT key and drag with the 
mouse wheel) see Figure 6.56. 

 
Figure 6.56 

The Fire Protection Pump System in 3D Conceptual Visual Style, shown with the 
View panel ‘torn off’ and floating. 

17. Using the Visual Styles button, return display to the 2D Wireframe visual style.  

18. Using the View button, return to Top view. 

19. Close the 01 Fire Protection.dwg file, and when prompted, save the file. 

Gravity Piping Fundamentals 
Gravity piping in AutoCAD MEP provides the ability for male connections to deflect when connecting to 
their female connection counterparts. This ability is allowed by reading specific values stored inside the 
Pipe catalog’s fittings and pipe connections on Multi View Parts. These values are Angle of Deflection 
(AoD) and the Connector Engagement Length (CEL). In this topic you will lay out a gravity piping 
system for the restrooms and gain additional understanding on how the male x female piping in AutoCAD 
MEP works.  
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To begin, let’s first review how fittings determine whether they are male or female. When the Connector 
Engagement Length (CEL) value stored within each pipe connection equals zero the connection is defined 
as male. When the value is greater than zero, then the pipe connection is female. Once the connection is 
determined to be female, the software will take into account the Angle of Deflection (AoD) value that is 
stored within each pipe connection to allow the connection to deflect up to the maximum angle. This 
fundamental connection method matches how female pipe connections are made during construction. To 
find out more about Content Builder and how to create and edit content, refer to Chapters 9 and 10. 

Furthermore, the actual connection location on female connections is located inside the fitting at the true 
location based on the defined CEL value. This is also used as the deflection point of the connected object, 
such as male fittings or pipe segments. In addition, since all pipe connections are defined as either male or 
female, the software also knows whether the fittings defined in the Routing Preference can connect 
directly together or need another object (such as a pipe between two female joints or a coupling between 
two male joints). This makes your layouts more accurate and reflective of the real world. Several options 
appear on the PipeAdd Properties palette during the PipeAdd command, and this fully supports sloped 
piping, allowing for better layouts, more precise slope control, and the conveyance of more information 
during layout (see Figure 6.57).  

 
Figure 6.57 

PipeAdd Property Palette 

1. Dimensions—The Routing preference allows you to select the Routing Preference that will be used during 
Pipe Layout. The Nominal Size is where the size is specified and Specify Cut Length allows you to set a 
specific cut length after the pipe run is complete. Cut lengths are applied to Pipe Segments only. 

2. Placement—The Start Elevation control reports the elevation of the first point of the pipe. This allows the 
Elevation control to update based on the slope value and simultaneously inform you of the original elevation 
from which you began the pipe run. 

3. Justification—The Justify control allows you to specify the justification of the pipe objects during placement. 
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The Horizontal and Vertical offsets allow you to specify a value to draw the pipe away from the current cursor 
position. This is very useful for piping layouts along a wall for example. You can specify a Horizontal offset 
distance to have the pipe drawn that distance away from the wall. 

4. Routing—In this grouping, Slope format and Slope are always active. The Slope format is a  Drop List control 
that is configured within the pipe preferences and informs you of the current pipe routing format. Pipe 
Preferences support several different formats such as Percentage, Fractional, Constant Rise or Run values and 
a multitude of measurement units. (We will look at Pipe preferences in more detail in the “Create a Floor Drain 
System” topic below.) You can change the current format by selecting the control and selecting the new format 
from the list available. The Branch angle control supports angles other than 90° when branching off a pipe 
with either a Tee or a Wye (Lateral).  

5. Advanced—This section allows you to access the Connection Details that state the current connection type on 
the Pipe Segment and the Flow direction. Insulation is where you specify the thickness of the insulation that 
will be applied on the Pipe and Fittings. 

6. Routing Options—The Use fitting tolerance control determines if the Angle of Deflection value will be 
considered during Auto Layout or not. This is the setting that determines if female fittings will deflect or not. 
The Joint Direction control allows you to specify the orientation of Male x Female fittings during layout, to 
determine if the male end of the fitting should go into the female connection or have the female object placed 
first. The Branch fittings supported are: Takeoffs, Tee Only, Tee or Wye (Lateral), Wye Only and Wye 
(Lateral) or Tee. Using the Tee or Wye / Wye or Tee methods allows Auto Layout to determine solutions using 
both fittings and will place the first fitting when both fittings have the same angle values. This allows for the 
most comprehensive set of solutions to be found with constrained layout. We will be using these controls in 
the exercises below.  

7. Routing Options—The Labels and Flow arrow section is where you can specify if the pipe should have 
Labels and / or flow arrows added to the pipe run during layout. These controls are also in the Pipe Preferences 
to allow you to set the values in the templates. 

Using Auto Layout in sloped pipe layouts with fitting tolerances turned on will split the deflection to each 
connector equally, thus allowing twice the maximum Angle of Deflection to be utilized during layout. In 
addition, when the joint specified is female and supports Angle of Deflection, Auto Layout will add 
couplings as necessary to make up for minor angle differences instead of adding a custom angled elbow. 
For example when you draw a pipe at slope zero and then change the slope to -1, the coupling stored in 
the Routing Preference will be added to account for this slope change (see Figure 6.58). 

 
Figure 6.58 

PipeAdd automatically adds couplings when needed 
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In the following topics we will explore these settings as we lay out a floor drain system and a sanitary 
piping system. 

Floor Drain System Layout 
In the next two exercises we will be laying out a floor drain system and a sanitary system using Piping. 
We will explore how piping works in sloped conditions and use the associated controls to leverage the 
slope functionality. 

Create a Floor Drain System 
Before we begin, we will change our Display Configuration from MEP Design to MEP Basic 2 – Line. 
The Basic 2 Line Display Configuration displays all piping as 2 line regardless of the Single Line 
Graphics settings in the Pipe System Definition, and turns off Hidden Lines. This allows you to see two 
line piping, even for small diameter piping that would otherwise display as Single Line or Graphical One 
Line in the MEP Design display configuration. For more information on Display Configurations, see 
Chapter 12. 

1. On the Project Navigator palette, on the Constructs tab, under the Constructs 
folder, expand the Plumbing folder.  

2. Double-click to open the 01 Plumbing construct drawing. 

3. Zoom in on the restroom area in the upper right-hand corner.  

Floor drains are already located in both restrooms. Please see the 
“Plumbing” topic in the Quick Start Chapter for more information on how to 
layout the floor drains. 

4. On the Drawing Status Bar (lower right corner of the drawing window) change the 
Display Configuration to: MEP Basic 2-Line (see Figure 6.59). 

 
Figure 6.59 

Switch the Display Configuration to Basic 2-Line 

Let’s add the piping required for the floor drains for the two restrooms on the first floor and locate the 
main drainage stack into which the other floors will connect.  

5. On the Gravity Pipe Tool palette, scroll down to the By System group. 

6. Click the Sanitary tool. 

7. On the Properties palette, set the Routing Preference to: Cast Iron Soil Pipe – 
Bell x Spigot. 

8. At the command line, type PCON and then press ENTER.  
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9. Select the floor drain in the upper (Women’s) restroom. 

10. On the Properties palette, change the Elevation to -1'-0". 

CAD Manager: When routing pipe using the Plus (+) Grip from plumbing equipment MvParts, by default Plumbing 
Line (2D) will be drawn. You can route 3D Pipe by holding the CTRL key when clicking the grip. To permanently 
change this behavior to instead route 3D Pipe by default, you can edit the AecbDomainConfig.xml file located at 
C:\ProgramData\Autodesk\MEP 2011\enu\Shared\AecbDomainConfig.xml. The string that needs to be changed is: 
<PartTypeEnum globalStr="Appliance" isPlumbingFixture="True" /> You must change the word “True” to “False” for 
each part type that you want to start the PipeAdd command instead of the Plumbing Line Add command. Please 
note: You should use Notepad.exe to edit this file so the header information is not corrupted. Remember to create a 
copy of the original file before you begin editing any XML file. 

Before we set the slope, we are going to change the slope format as mentioned above. 

11. On the Properties palette, scroll down to the Routing Section, select the Slope 
Format Drop list..  

12. Change the Slope format to: Fractional Rise (Inches), Run=(12 Inches) (ex. ¼ 
where run is 12) (see Figure 6.60). 

 
Figure 6.60 

Setting the Slope Format in Pipe Preferences 

When you input a slope value such as -¼ it will be applied over 12" making a ¼" / 1'-0" slope pitching 
down. A positive number slopes up and a negative number slopes down. 

13. On the Properties palette, in the Routing grouping, change the slope to -12" to 
pitch the pipe away from the drain at 45 degrees.  

14. Move the mouse horizontally to the left and then click a point in the middle of the 
Stall Door (see Figure 6.61). 

15. On the Properties palette, in the Routing grouping, change the slope to -1/4" to 
pitch the pipe away from the drain.  

16. Move the mouse horizontally to the left and then click a point just beyond the Stall 
to add a 45-degree elbow (see Figure 6.61). 
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17. Move the mouse horizontally to the left and then click a point just beyond the 
Corridor hallway. 

 
Figure 6.61 

Laying out the Sanitary Floor Drain Piping 

18. Move at 45° (the compass will read either 45 or 135) and then click another point in 
the middle of the corridor (see Figure 6.62). 

19. Click the next point just inside the upper horizontal wall.  

20. At the command line, type E, press ENTER and type -5'-0", and then press enter. 

21. Finally, pick a point outside the wall and then press ENTER to exit the PipeAdd 
command (see Figure 6.62). 

 
Figure 6.62 

Completed Floor Drain layout 

Connect a Second Drain  
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Following a similar process, we will connect to the drain in the Men’s restroom.  
22. Select the 45-degree elbow in the corridor, and then click the plus grip (+) that 

appears pointing toward the Men’s Room (see Figure 6.63). This will upgrade the 
45-Degree Elbow into a Lateral. 

 
Figure 6.63 

Upgrading the 45 Degree Elbow into a Lateral 

Note: When upgrading Male x Female Elbows into a Lateral or a Tee, the part in the 
Routing Preference must support the same Male x Female Connection Orientation 
to be successfully completed. 

This starts the PipeAdd command again, updates the Properties palette 
with all the settings from the fitting you selected, and upgrades the elbow. 

Since we will be drawing this pipe toward the drain instead of away from it, verify that the slope changed 
from negative to positive and you will need to change the Joint Direction from Male into Female to 
Female out to Male. 

23. On the Properties palette, in the Routing grouping, verify the slope is set to 1/4" 
(see Figure 6.64). 

24. Under the Advanced Section change the Joint Direction to Female out to Male (see 
Figure 6.64). 

 
Figure 6.64 

Upgrading the 45-Degree Elbow into a Lateral 
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25. Click a point in the Men’s restroom approximately under the right most sink (see 
Figure 6.65). 

26. Type PCON at the command line to use the Pipe Connector snap and select the 
Drain. 

The auto layout controls will give different options for you to choose. You 
can review each option by selecting NEXT at the command line.  

 
Figure 6.65 

Connecting to the Drain in the Men’s Room. 

We have just covered how to route Male x Female piping in AutoCAD MEP. The Joint Direction control 
allows you to route with the flow using Male into Female and opposite the flow using Female out to 
Male. You can also upgrade Elbows into Tees when upgrading a 90-Degree elbow or a Lateral when 
upgrading a 45-degree elbow. In addition, you can add Laterals to pipe segments by using the Plus Grip 
in the Pipe and pointing away at 45 degrees. 

 
Figure 6.66 

The Complete Floor Drain Layout 

Bathroom Sanitary Piping System 
In the Quick Start Chapter we used Schematic Plumbing Line to lay out the sanitary piping from the 
Water Closets to the outside of the building. In this exercise we are going to create a similar system using 
3D Piping. 
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Continue in the area around the restrooms. 
To begin, you need to overlay an AutoCAD MEP Water Closet on top of the Architectural Water Closets 
if you want to maintain connectivity.  

Note: An alternative is to supply the Architect with the Water Closet Mvpart that you use 
and ask that they replace their mvblock with your AutoCAD MEP version. Also, 
you can convert their mvblock into an Mvpart and send the updated object back to 
the Architect for inclusion into their drawings. For this exercise, you will simply 
place the Mvpart on top of the Architectural one. 

27. On the Home tab, on the Build panel, click the Equipment button. 

28. Scroll to the bottom and expand the Plumbing folder and then the Water Closet 
folder. 

29. Select the Floor-Mounted Flush Valve Water Closet and place one at each Water 
Closet location. 

Tip: You can use the AutoCAD insertion object snap (INS) to snap to the 
architectural toilets. 

30. Expand the Urinals folder, select the Wall-Hung Urinal. 

31. Set the Elevation to 1’-0” 

32.  Toggle on the Replace Z value with current elevation control. 

33. Snap to the insert of the architectural urinal, and rotate the urinal into place. 

34. Press ESC to finish adding equipment. 

35. On the Gravity Pipe Tool palette, in the By System grouping, click the Sanitary tool. 

36. Set the Routing Preference to Glued. 

Start with the right-most water closet in the upper (Women’s) restroom. 

37. Type PCON at the command line and select the sanitary connection on the bottom 
of the water closet. 

38. On the Properties palette, change the Elevation to -8" to go below the slab. 

39. On the Properties palette, change the Slope to -1/4", verify that the Slope format is 
still set to Fractional Rise. 

40. Click a point near the middle of the cavity wall. 

41. Pick a point perpendicular to the last point (moving to the left) by the end of the 
accessible stall. 

42. On the Properties palette, change the size to: 4".  

43. Click the next point along the same line approximately at the midpoint between the 
sinks. 

44. Change the size to: 6". 

45. Click a point just inside the wall. 

46. Change the elevation to -6'-0". 
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47. Click the next point in the hallway at 45°, and then click the final point outside the 
building by the drain pipe (see Figure 6.67). 

48. Press ESC to end the pipe run. 

 
Figure 6.67 

Complete the main run of Sanitary Piping 

49. Select the elbow behind the water closet and then click the bottom plus (+) grip. 

50. On the Properties palette, change the slope to ¼". 

51. Click a point towards the opposite water closet to apply the slope. 

52. Click on the sanitary connection on the bottom of the water closet and then accept 
the solution that mirrors the layout in the women’s restroom. 

The piping command continues and the command line prompts you for a 
new Start point. Note that even though a tee was placed, we will modify 
this later to utilize a more appropriate fitting type. 

53. Click on the sanitary connection on bottom of the next water closet in the Women’s 
room. 

54. Change the elevation -8” 

55. Click a point on the main pipe. 

56. Accept the tee solution.  

57. Repeat the process for the water closet on the left in the upper (Women’s) 
restroom. 

58. Press ENTER to complete the command.  

59. Select the Tee between the back-to-back water closets and then click the plus (+) 
grip. 

60. Change the slope to ¼" and then change the Nominal size to 3". 

61. Click on the sanitary connection of the water closet (see Figure 6.68).  
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Figure 6.68 

Complete the Water Closet Layout 

We can change the part applied in the automatically generated solutions with a different part where 
needed. In this case, we are going to swap out the standard cross with a double sanitary cross. We will do 
this using the Properties palette.  

62. Select the Cross. On the Properties palette, click the image next to Part.  

The “Select a part” fitting selection dialog will appear and will be filtered by 
the Subtype Straight.  

63. Change the Subtype filter to All (see Figure 6.69). 

 
Figure 6.69 

Modifying an existing Fitting 

64. In the Glued folder, select the Glued – Sch 40 – Short Double Sanitary Tee.  

65. Click OK  
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Figure 6.70 

Selecting the 4" Short Double Sanitary Tee 

We now have the correct fitting, but it points the wrong way.  

66. With the fitting still selected, simply select the flip grip to orient the fitting in the 
correct direction (see Figure 6.71). 

 
Figure 6.71 

Flip the Fitting to the proper orientation 

Now we want to upgrade the end tee to a cross to vent the pipe. 

67. Select the tee at the right end of the run, and then click the plus (+) grip. 

68. Draw the new pipe towards the wall on the right.  

69. Make sure the Slope Format is still Fractional Inches, and that the Slope is set to 
1/4" 

70. Change the elevation to: 12'-0" to go to the next floor and then press ENTER (see 
Figure 6.72). 
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Figure 6.72 

Upgrade Tee to Cross then change Elevation to span to the floor above 

Before we replace the Cross with a Double Sanitary Tee we need to rotate it so the Connectors are in the 
correct orientation and the cross will be oriented with the flow direction. 

71. Select the cross, and then click the midpoint rectangular grip. 

72. Press the SPACEBAR twice to invoke the grip rotate command.  

73. Type 270 and then press ENTER. 

The water closet connections to the cross will become disconnected, due to the different laying length of 
the two crosses and this is expected; we just need to redraw the pipes from the elbows under the water 
closets to the cross (see Figure 6.73). 

 
Figure 6.73 

Reconnecting the Toilets to the Main 

We just learned how to lay out Gravity Piping using Slope to pitch the pipe away from the equipment 
using a negative slope value or towards the equipment using a positive value. We also learned how to set 
access and change the Slope Format during layout. And we covered how to change fittings using the 
Properties palette to swap out a Cross with a Double Sanitary Tee (Cross) and to use the flip grips to 
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orientate the fitting in the correct direction. Leveraging the Plus (+) Grips to continue the pipe run is 
essential to inherit the settings on the Properties palette for the Pipe. 

We are done with this exercise. We have learned how to lay out piping with a slope, how to replace 
existing fittings using the Properties palette, and how to upgrade fittings from elbows to tees and from 
tees to crosses. 

The elbow that turns down at the end of the wall by the corridor can be upgraded to a tee in the vertical to 
become the stack for the other floors. Feel free to continue to lay out the restroom and extend the stack up 
to the next floor. The completed water closet and urinal piping layout is provided in the Plumbing 
Complete folder as a file named: 01 Plumbing Complete with the files you installed from the CD ROM. 
Feel free to open the file and compare it to your work. 

Note: You can run interference detection to check to see if the sanitary piping and the 
floor drain piping are clashing. To do this, go to the Analyze tab and click the 
Interference Detection tool. Select Pipe and then click the Start Analysis icon at 
the bottom of the palette. For more information on interference detection, see 
Chapter 14. 

We also covered how to use AutoCAD’s grip functionality to rotate the fitting to the correct orientation so 
the pipes pitch in the right direction. 

Preparations for Sprlinkler Layout 
Our final task in this chapter will be to complete the sprinkler piping layout for the first floor of the 
project.  

1. On the Project Navigator palette, on the Constructs tab, under the Constructs 
folder, expand the Fire Protection folder.  

2. Double-click to open the 01 Fire Protection construct drawing. 
Before we begin with the sprinkler piping layout, we need to determine the correct elevation for the 
sprinkler main and branches. To do this, we will add the second floor framing to this file as an XREF and 
then create a live section through the building. This will provide a clear understanding of the space and 
allow us to easily assess the available clearances.  

3. On the Project Navigator palette, on the Constructs tab, under the Constructs 
folder, expand the Structural folder.  

4. Drag 02 Framing from the Structural folder and drop it into the drawing window. 

5. On the Home tab, on the Sections & Elevations panel, click the Section Line tool 
(see Figure 6.74). 

 
Figure 6.74 

The Section Line tool on the Home tab 

6. Click two points to draw a horizontal line through the middle of the building. 
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A Section line can have more than two points. Therefore, the “Specify next 
point” prompt continues to repeat after you click the second point.  

7. Press ENTER to finish placing section line points.  

8. At the “Enter length” prompt, press ENTER again to accept the default.  

The default creates a section that is 20'-0" deep. This is how far it “looks” into the building. You can 
always select the section line and edit the depth with the grips later. Now that you have the section line, 
you can use it to generate a 2D section or enable a live section. In this exercise, you will enable a live 
section. For more information on sections, refer to Chapter 13.  

9. On the View tab, on the Appearance panel, choose SE Isometric to change the 
view to a 3D view.  

10. Select the section line.  

11. On the Building Section Line tab of the ribbon click the Enable Live Section button. 

As you can see, this limits the model view to display only what is within the 
section box. This tool is extremely helpful in isolating sections of buildings 
and layouts to facilitate working in 3D (see Figure 6.75). 

 
Figure 6.75 

Enabling a Live Section crops the 3D model to display only the AEC geometry 
that falls within the section box 

12. On the View tab, on the Appearance panel, choose Left view. 
Now you need to determine the bottom of steel. 

13. On the Analyze tab, click on the Inquiry panel title.  

The panel will expand to reveal several additional tools.  

14. Click the ID Point tool.  
Note: If you prefer you can type ID at the command line instead. 
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15. Using the Nearest osnap, ID the lowest points on the Steel objects (see Figure 
6.76). If you are getting a Z value of 0, make sure the Replace z value with current 
elevation is toggled off. 

The results will appear on the command line. If they have scrolled past, you can press the F2 key to open 
the text window. The Steel should be at a Z elevation of 9'-11 3/32", and the HVAC at a Z elevation of 9'-
0" 

 
Figure 6.76 

Identify the Elevation of the bottom of Steel and HVAC 

Create the Sprinkler Main 
Now that we have the elevations of the steel and the HVAC in the drawing, we can lay out the sprinkler 
main and the branch locations with this information in mind. 

Note: In your own projects, if you do not receive backgrounds that contain 3D geometry, 
you will not be able to perform this process to determine the clearance heights. In 
that case, simply ask your Architect, Structural Engineer, and/or Mechanical 
Engineer to provide this information to you. Even when 3D models are provided, 
you should communicate with your team to ensure that heights and other 
clearances are drawn accurately to avoid costly change orders later.  

To begin the process of laying out the sprinkler system, it will be helpful to see our work progress in both 
plan and section. Therefore, we will split the screen into two viewports.  

16. On the View, tab on the Viewports panel, click the Viewport Configurations List 
drop-down button and then choose Two: Vertical (see Figure 6.77).  

This will split the screen into two tiled viewports.  
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Figure 6.77 

Setting up multiple tiled viewports 

You will now have two viewports of the model on screen. You can make either active by simply clicking 
in it. The outline will appear bold to indicate the active viewport.  

17. Click on the viewport on the left to activate it.  

18. On the View tab, on the Appearance panel, select Top view. 

Notice that the entire model is restored. Live section does not apply to plan view. The model is still 
cropped in the right side viewport, however.  

19. Click in the right viewport to activate it. 

20. On the Appearance panel, scroll the view buttons to locate Front view and then 
click it (see Figure 6.78).  

Notice that the Front view is cropped by the section line. If necessary, you can adjust the section box in 
the plan view using the grips to make the live section larger or smaller. The results will apply 
immediately to the front view in the right viewport.  

 
Figure 6.78 

Set up the tiled viewports to show a plan on the left and front view on the right 
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21. Zoom in on the Fire Protection room in both viewports. 

22. In the Front view, select the Fire Protection Pipe that goes up to elevation 12'-0" 
and erase it (see Figure 6.79). 

23. Select the Coupling off the Elbow going up, and then click the plus (+) grip (see 
Figure 6.79). 

24. On the Properties palette, set the Elevation to 9'-6" and then click the Lock icon.  

 
Figure 6.79 

Erasing and replacing the vertical sprinkler pipe 

This locks the specified elevation and constrains all the pipes drawn to this elevation. You can still set a 
new elevation in the palette, but when you connect to another pipe the specified elevation will remain. 
Also, when you are drawing close to other objects at different elevations, those objects will be ignored. 

25. Click in the Plan view viewport to begin drawing the pipe header. 

26. Type P and then press ENTER.  

1. This will change the AutoCAD MEP Compass to the plan view. You 
should now see the compass circle (see Figure 6.80). 

 
Figure 6.80 

Setting the Compass to Plan view 

27. Click a point just beyond the wall so an elbow is added. 
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28. On the Properties palette, change the size to 4". 

29. Draw the pipe to the middle of the building and click. 

30. In the “Choose a Part” dialog that appears, under Steel Pipe (US Imperial), select 
Grooved - Flexible Coupling 0.75 – 12 Inch, and then click OK.  

31. Move horizontally to the left side and click again (see Figure 6.81). 

 
Figure 6.81 

Lay out the 4" Fire Protection Main down the middle of the building 

32. Select the elbow and click the plus grip along the horizontal pipe to upgrade the 
elbow to a tee.   

33. Continue the pipe to the right end of the building.   

We have now created the Fire Protection Header. 

Create the Branch Lines 
Now we need to begin to lay out the branches for the sprinkler system, but first we can detach the 
Structural Framing XREF. This will reduce some of the visual clutter on screen and make it easier to 
work in plan.  

1. On the Project Navigator palette, right-click on the 01 Fire Protection construct and 
choose External References.  

2. In the “External References” dialog, right-click on 02 Framing, choose Detach — 
(see Figure 6.82). 
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Figure 6.82 

Detaching an XREF with Project Navigator 

3. On the Home ribbon tab, on the Build panel, click Pipe.  

4. Click a point on the header approximately 4'-0" away from the wall at the left end of 
the building (the distance is not that important—we will move the pipe later). 

5. On the Properties palette, change the size to 2" and then pick a point toward the 
north side of the building just inside the wall. 

We now want to set the distance between the pipe and the wall to be 4'-0". 

6. On the Annotate tab, on the Dimensions panel, click the Dimension, Linear tool. 

7. At the “first extension line origin” prompt, click a point on the inside face of the wall.  

8. At the “second extension line origin” prompt, click the end of the pipe using the 
PCON snap.  

The dimension will tell you the current distance. Since we want the distance to be 4'-0", you can simply 
do the math to figure out how far to the left or right the pipe needs to move. Once you have this value, 
you can move the pipe this amount. Use the AutoCAD move command or the Location grip on the pipe.  

9. Select the Pipe and then click the square grip at the midpoint. 

10. Move your cursor horizontally in the direction that it needs to move. 

11. Type in the distance that will bring you to 4'-0" and then press ENTER (see Figure 
6.83). 

 
Figure 6.83 

Use a dimension to assist in locating the Fire Protection Pipe. 
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To verify your work, you can edit the dimension with grips to the new 
location. You can delete the dimension when you are finished. 

12. Select the tee that branches off the main, select the plus (+) grip, change the size 
to 2", and then route a pipe to the south wall of the building. 

That completes the basic branch setup. 

Adding Sprinkler Heads 
74. Select the Branch Pipe at the northwest corner of the building, click the middle plus 

(+) grip, and then on the Properties palette in the Routing Options grouping (under 
Advanced) change the Branch fitting to: Takeoff only (see Figure 6.84).  

 
Figure 6.84 

Changing Branch Fitting to Takeoff only 

13. Set Nominal size to ½". 

14. Set Elevation to 8'-6". 

15. Press ENTER to exit the pipe command. 

16. Click in the right (Front) viewport to activate it. 

17. On the View tab, change to the Left view. 

Tip: In the Plan view you can select the Section Box and, using the grips, drag 
the box smaller to surround only the branch pipe you just drew. This allows 
for the Left viewport to show just the branch pipe. 

18. Zoom in on the pipe you just added. 
As you can see, we added a vertical drop of pipe at the spot indicated in plan. We now need to add the 
sprinklers to the line. 

19. On the Home tab, on the Build panel, click the Equipment tool.  
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20. In the “Add Multi-view Parts” dialog that appears, expand the Mechanical folder, 
then the Fire Protection folder, and finally the Sprinklers folder. 

21.  Select the Pendent Sprinkler – US Imperial item. 

22. At the bottom of the dialog, select the 0.5 Inch Pendent Sprinkler - Standard 
Coverage Standard Response from the “Part Size Name” list. 

23. In the Left viewport, place the part at the end of the vertical pipe you just drew. 
Press ENTER to accept the default rotation (see Figure 6.85). 

 
Figure 6.85 

Place the sprinkler at the end of the ½" Pipe 

24. Close the “Add Multi-view Parts” dialog.  

25. Click in the left (Plan) viewport to activate it. 

Use the stretch command, using a window around the sprinkler, and stretch the sprinkler so it is about 4’-
0” north of the main. Now we have a single Sprinkler head on the branch. We are going to use the Array 
command to add the rest of the sprinklers to this side of the main and then use the mirror command to add 
them to the opposite side. 

26. In the Plan viewport, click above and to the left of the sprinkler and then click down 
and to the right to create a window selection.  

This will select the sprinkler, pipe and takeoff. On the ribbon, a Multiple 
Objects tab will appear.  

27. On the Home tab, click on the Modify panel title.  

The panel will expand to reveal several additional tools.  

28. Click the AEC Array tool (see the top left corner of Figure 6.86) (AEC Array is also 
available on the right click menu on selecting AEC Modify Tools.) You can also use 
the AutoCAD Array command to complete this step. 

29. At the “Select an edge to array” prompt, click on the main. 

A light blue line will appear on the main before you click to confirm 
selection (see the bottom left corner of Figure 6.86). 

30. Move the mouse out toward the upper outside wall. 
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Several squares will appear to indicate where the copies will appear. The default distance between arrayed 
items is 3'-0". To change this distance in the AEC Array command, you can use Dynamic Input. You can 
turn this on with the toggle on the Application Status bar at the bottom of the screen (see the bottom of 
Figure 6.86). Alternatively, you can type P at the command line to Pick array distance. 

31. Type 8'-0" in the dynamic dimension on screen (it will appear near the midpoint of 
the main) and then press enter (see the middle of Figure 6.86).  

 
Figure 6.86 

Array the sprinkler heads using the AEC Array tool 

32. The squares will adjust and a tooltip will confirm the new spacing. To accept the 
array, click the mouse (see the right side of Figure 6.86). 

The objects have been arrayed along the pipe and automatically 
connected.  
Note: Array, Mirror, Copy and Move are enhanced AutoCAD MEP commands which 

allow AutoCAD MEP objects to align automatically to other AutoCAD MEP objects 
when the objects are on the same UCS plane.  

Let’s copy the arrayed sprinklers to the lower branch. 

33. On the Home tab, on the Modify panel, click the Copy tool (see Figure 6.87). 

 
Figure 6.87 

The Copy Command on the Ribbon 

34. Make a window selection (click from left to right) to surround all of the previously 
arrayed sprinklers and then press ENTER. 
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35. Select a basepoint, move your cursor straight down towards the bottom of the 
screen, type 32'-0", and then press ENTER. 

This will copy the sprinklers to the other header. 
Using array again, we can make copies of the entire branch and all its sprinklers to complete the layout.  

36. Window Select both branches. (Surround the entire branch to select the branches, 
the sprinkler heads, and fittings, including the tee at the main.)  

37.  On the Home tab, click on the Modify panel title to expand it and then click the 
AEC Array tool. 

38. Click on the branch at the edge to array.  

39. Type 7'-9" and then press ENTER in the dynamic dimension  

40. Drag out the array across the building and then click to complete it (see Figure 
6.88). 

 
Figure 6.88 

Using AEC Array to copy the branches and sprinklers across the building 

The branches are laid out along the entire ceiling. You can go through and delete unnecessary sprinkler 
heads and terminate the pipes that go into the Foyer as well as into the Elevator area (see Figure 6.89). 
Note also, the crosses don’t break into the main with this array operation, you may also want to break the 
main across each of the tees, then use grip edits to attach the main into the tees. 
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Figure 6.89 

The completed First Floor Sprinkler System 

Make any other fine-tuning adjustments that you like.  

41. When you have completed your layout, save and close all project files.  

Summary 
Throughout this chapter, we have reviewed many key aspects of the 3D piping tools in AutoCAD MEP 
2011. We have put these concepts into practice in our sample commercial office building. You should 
now have a good feel for how 3D piping works as well as an understanding of specific systems such as 
fire safety layouts and restroom gravity piping. In this chapter we have learned: 

• The Piping Feature in AutoCAD MEP allows for accurate creation of models in a fast and accurate manner. 
• Routing Preferences are used to establish the preferred fittings during layout. 
• System Definitions define how the System is abbreviated in annotation, and how it is displayed in Graphical 1 Line, 

Single Line, and 2 Line displays. 
• System Definitions also control overrides to the default display, allowing for Centerlines to be displayed.  
• Sloped piping controls provide for female fittings to have an allowable angle of deflection to make a 90°-elbow bend at 

angles other than 90°. 
• The ability to route Male x Female piping.  
• The ability to automatically lay out Laterals during Auto Layout improves the overall control of how the pipe system is 

created.  
• The ability to upgrade 45-Degree Elbows into Lateral. Utilizing the grip functionality in AutoCAD MEP is essential to 

creating real world layouts.  
• The Associated Movement ability, or StickyMove, displays the power of AutoCAD MEP. This functionality allows us to 

use the grips to move and automatically remove unwanted fittings and pipe segments. 
• Leveraging AutoCAD commands like Copy and Array helps us to create repetitive layouts quickly and easily while 

automatically maintaining relationships to other AutoCAD MEP objects. 
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	Press ESC to complete the pipe command.

	Fire Pump Discharge Piping
	Select the right pump and then click the discharge plus (+) grip.
	On the Properties palette, change the Justification to Center. Change the size to 6",
	The “Choose a Part” dialog will appear to select a Flanged Reducer.
	Under Steel Pipe (US Imperial), select the Flanged – Class 150 – Reducer, and then click OK.
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	Change the Elevation to 12'-0" and then press enter to exit the command.
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	Click a point on the horizontal pipe along the bottom wall (see Figure 6.46) to connect the discharge piping.
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	Press esc to end the pipe command.
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	On the Home tab, on the Build panel, click the Equipment drop-down button and choose the Valve tool.
	Expand the Valves folder and then select the Gate Valves US Imperial item.
	Remember, do not close the “Add Multi-view Parts” dialog; simply click in the drawing to shift focus there.
	At the command line, type pcur and then press enter.
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	Type p and then press enter.
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	Press enter again.
	The “Choose a Part” dialog will again appear asking for the appropriate flange to use.
	Expand the Steel Pipe Catalog. Scroll down and select the Grooved – Class 150 – Flanged Adaptor 2-12 Inch and then click OK (see Figure 6.47).
	Pick on the 6” pipe leading to the left pump’s suction end and repeat the process to add another valve (see Figure 6.48).
	Repeat the process to add two more valves to the discharge piping. Place one right before the elbow (right pump) and the other right before the Tee (left pump) as shown in Figure 6.49.
	After placing the valve, select it, hold down the ctrl key, and click the flip grip to rotate the valve 90 degrees instead of 180 (see Figure 6.49).
	On the Home tab, use the Equipment drop-down to add another Valve.
	In the “Add Multi-view Parts” dialog, select the Check Valves US Imperial item.
	Click on the discharge pipe before the gate valve in the locations shown in Figure 6.50. Use the mouse to indicate the rotation. (Remember you can always flip it with the grip later if necessary).
	In the “Choose a Part” dialog, select the Grooved Flanged adapter again.
	Editing Pipe Layouts

	Remove Unnecessary Pipes
	Select the Gate Valve on the Suction Piping for the Left Pump.
	Click the rectangular grip on the side opposite the pump.
	Drag the rectangular grip to the connector of the tee and snap using the PCON snap (see Figure 6.51).
	Repeat this process to move all the valves to the associated fittings (see Figure 6.52).
	On the Home tab, click on the Modify panel title.
	The panel will expand to reveal several additional standard AutoCAD drafting tools.
	Click the Break tool (see Figure 6.53).
	If you prefer, you can type break at the command line (br is the shortcut).
	At the “Select object” prompt, select the pipe between the Check valve and the Gate valve for the right pump.
	Move the mouse slightly and then click the second point of the break so that the pipe is in two parts (see Figure 6.54).
	Repeat for the left pump piping.
	Select the broken pipe connected to the Gate valve. On the Properties palette change the elevation to 8'-0".
	All the horizontal piping and valves connected to this pipe will move to 8'-0". To verify this, simply hover your cursor over the objects and the Tooltip will indicate the new elevation (see Figure 6.54).
	Now that the discharge piping has changed elevation we can connect the two pipes and add the associated elbows.
	Select the pipe connected to the Gate valve, click the plus (+) grip, and then click the pcon (Pipe End Connector) snap on the pipe connected to the Check valve.
	Multiple solutions will appear; please select number one as indicated in Figure 6.55.
	Repeat the process for the other pump.
	On the View ribbon, Appearance panel, choose View, NE Isometric from the View list.
	On the View ribbon, Visual Styles panel, choose Conceptual from the Visual Styles drop-down list.
	Note: the Home tab of the ribbon has a View panel that may be more convenient than switching to the View ribbon (see Chapter 1 for more details on the ribbon). You can also ‘tear off’ the View panel so it is floating and always available.
	Click and drag the ViewCube in the upper right corner of the screen to orbit the view to a steeper angle. (You can also hold down the shift key and drag with the mouse wheel) see Figure 6.56.
	Using the Visual Styles button, return display to the 2D Wireframe visual style.
	Using the View button, return to Top view.
	Close the 01 Fire Protection.dwg file, and when prompted, save the file.

	Gravity Piping Fundamentals
	Floor Drain System Layout

	Create a Floor Drain System
	On the Project Navigator palette, on the Constructs tab, under the Constructs folder, expand the Plumbing folder.
	Double-click to open the 01 Plumbing construct drawing.
	Zoom in on the restroom area in the upper right-hand corner.
	Floor drains are already located in both restrooms. Please see the “Plumbing” topic in the Quick Start Chapter for more information on how to layout the floor drains.
	On the Drawing Status Bar (lower right corner of the drawing window) change the Display Configuration to: MEP Basic 2-Line (see Figure 6.59).
	On the Gravity Pipe Tool palette, scroll down to the By System group.
	Click the Sanitary tool.
	On the Properties palette, set the Routing Preference to: Cast Iron Soil Pipe – Bell x Spigot.
	At the command line, type pcon and then press enter.
	Select the floor drain in the upper (Women’s) restroom.
	On the Properties palette, change the Elevation to -1'-0".
	On the Properties palette, scroll down to the Routing Section, select the Slope Format Drop list..
	Change the Slope format to: Fractional Rise (Inches), Run=(12 Inches) (ex. ¼ where run is 12) (see Figure 6.60).
	On the Properties palette, in the Routing grouping, change the slope to -12" to pitch the pipe away from the drain at 45 degrees.
	Move the mouse horizontally to the left and then click a point in the middle of the Stall Door (see Figure 6.61).
	On the Properties palette, in the Routing grouping, change the slope to -1/4" to pitch the pipe away from the drain.
	Move the mouse horizontally to the left and then click a point just beyond the Stall to add a 45-degree elbow (see Figure 6.61).
	Move the mouse horizontally to the left and then click a point just beyond the Corridor hallway.
	Move at 45  (the compass will read either 45 or 135) and then click another point in the middle of the corridor (see Figure 6.62).
	Click the next point just inside the upper horizontal wall.
	At the command line, type e, press enter and type -5'-0", and then press enter.
	Finally, pick a point outside the wall and then press enter to exit the PipeAdd command (see Figure 6.62).

	Connect a Second Drain
	Select the 45-degree elbow in the corridor, and then click the plus grip (+) that appears pointing toward the Men’s Room (see Figure 6.63). This will upgrade the 45-Degree Elbow into a Lateral.
	This starts the PipeAdd command again, updates the Properties palette with all the settings from the fitting you selected, and upgrades the elbow.
	On the Properties palette, in the Routing grouping, verify the slope is set to 1/4" (see Figure 6.64).
	Under the Advanced Section change the Joint Direction to Female out to Male (see Figure 6.64).
	Click a point in the Men’s restroom approximately under the right most sink (see Figure 6.65).
	Type PCON at the command line to use the Pipe Connector snap and select the Drain.
	The auto layout controls will give different options for you to choose. You can review each option by selecting next at the command line.

	Bathroom Sanitary Piping System
	Continue in the area around the restrooms.
	On the Home tab, on the Build panel, click the Equipment button.
	Scroll to the bottom and expand the Plumbing folder and then the Water Closet folder.
	Select the Floor-Mounted Flush Valve Water Closet and place one at each Water Closet location.
	Expand the Urinals folder, select the Wall-Hung Urinal.
	Set the Elevation to 1’-0”
	Toggle on the Replace Z value with current elevation control.
	Snap to the insert of the architectural urinal, and rotate the urinal into place.
	Press ESC to finish adding equipment.
	On the Gravity Pipe Tool palette, in the By System grouping, click the Sanitary tool.
	Set the Routing Preference to Glued.
	Start with the right-most water closet in the upper (Women’s) restroom.
	Type pcon at the command line and select the sanitary connection on the bottom of the water closet.
	On the Properties palette, change the Elevation to -8" to go below the slab.
	On the Properties palette, change the Slope to -1/4", verify that the Slope format is still set to Fractional Rise.
	Click a point near the middle of the cavity wall.
	Pick a point perpendicular to the last point (moving to the left) by the end of the accessible stall.
	On the Properties palette, change the size to: 4".
	Click the next point along the same line approximately at the midpoint between the sinks.
	Change the size to: 6".
	Click a point just inside the wall.
	Change the elevation to -6'-0".
	Click the next point in the hallway at 45 , and then click the final point outside the building by the drain pipe (see Figure 6.67).
	Press ESC to end the pipe run.
	Select the elbow behind the water closet and then click the bottom plus (+) grip.
	On the Properties palette, change the slope to ¼".
	Click a point towards the opposite water closet to apply the slope.
	Click on the sanitary connection on the bottom of the water closet and then accept the solution that mirrors the layout in the women’s restroom.
	The piping command continues and the command line prompts you for a new Start point. Note that even though a tee was placed, we will modify this later to utilize a more appropriate fitting type.
	Click on the sanitary connection on bottom of the next water closet in the Women’s room.
	Change the elevation -8”
	Click a point on the main pipe.
	Accept the tee solution.
	Repeat the process for the water closet on the left in the upper (Women’s) restroom.
	Press enter to complete the command.
	Select the Tee between the back-to-back water closets and then click the plus (+) grip.
	Change the slope to ¼" and then change the Nominal size to 3".
	Click on the sanitary connection of the water closet (see Figure 6.68).
	Select the Cross. On the Properties palette, click the image next to Part.
	The “Select a part” fitting selection dialog will appear and will be filtered by the Subtype Straight.
	Change the Subtype filter to All (see Figure 6.69).
	In the Glued folder, select the Glued – Sch 40 – Short Double Sanitary Tee.
	Click OK
	With the fitting still selected, simply select the flip grip to orient the fitting in the correct direction (see Figure 6.71).
	Select the tee at the right end of the run, and then click the plus (+) grip.
	Draw the new pipe towards the wall on the right.
	Make sure the Slope Format is still Fractional Inches, and that the Slope is set to 1/4"
	Change the elevation to: 12'-0" to go to the next floor and then press enter (see Figure 6.72).
	Select the cross, and then click the midpoint rectangular grip.
	Press the spacebar twice to invoke the grip rotate command.
	Type 270 and then press enter.

	Preparations for Sprlinkler Layout
	On the Project Navigator palette, on the Constructs tab, under the Constructs folder, expand the Fire Protection folder.
	Double-click to open the 01 Fire Protection construct drawing.
	On the Project Navigator palette, on the Constructs tab, under the Constructs folder, expand the Structural folder.
	Drag 02 Framing from the Structural folder and drop it into the drawing window.
	On the Home tab, on the Sections & Elevations panel, click the Section Line tool (see Figure 6.74).
	Click two points to draw a horizontal line through the middle of the building.
	A Section line can have more than two points. Therefore, the “Specify next point” prompt continues to repeat after you click the second point.
	Press enter to finish placing section line points.
	At the “Enter length” prompt, press enter again to accept the default.
	On the View tab, on the Appearance panel, choose SE Isometric to change the view to a 3D view.
	Select the section line.
	On the Building Section Line tab of the ribbon click the Enable Live Section button.
	As you can see, this limits the model view to display only what is within the section box. This tool is extremely helpful in isolating sections of buildings and layouts to facilitate working in 3D (see Figure 6.75).
	On the View tab, on the Appearance panel, choose Left view.
	On the Analyze tab, click on the Inquiry panel title.
	The panel will expand to reveal several additional tools.
	Click the ID Point tool.
	Using the Nearest osnap, ID the lowest points on the Steel objects (see Figure 6.76). If you are getting a Z value of 0, make sure the Replace z value with current elevation is toggled off.

	Create the Sprinkler Main
	On the View, tab on the Viewports panel, click the Viewport Configurations List drop-down button and then choose Two: Vertical (see Figure 6.77).
	This will split the screen into two tiled viewports.
	Click on the viewport on the left to activate it.
	On the View tab, on the Appearance panel, select Top view.
	Click in the right viewport to activate it.
	On the Appearance panel, scroll the view buttons to locate Front view and then click it (see Figure 6.78).
	Zoom in on the Fire Protection room in both viewports.
	In the Front view, select the Fire Protection Pipe that goes up to elevation 12'-0" and erase it (see Figure 6.79).
	Select the Coupling off the Elbow going up, and then click the plus (+) grip (see Figure 6.79).
	On the Properties palette, set the Elevation to 9'-6" and then click the Lock icon.
	Click in the Plan view viewport to begin drawing the pipe header.
	Type p and then press enter.
	This will change the AutoCAD MEP Compass to the plan view. You should now see the compass circle (see Figure 6.80).
	Click a point just beyond the wall so an elbow is added.
	On the Properties palette, change the size to 4".
	Draw the pipe to the middle of the building and click.
	In the “Choose a Part” dialog that appears, under Steel Pipe (US Imperial), select Grooved - Flexible Coupling 0.75 – 12 Inch, and then click OK.
	Move horizontally to the left side and click again (see Figure 6.81).
	Select the elbow and click the plus grip along the horizontal pipe to upgrade the elbow to a tee.
	Continue the pipe to the right end of the building.
	We have now created the Fire Protection Header.

	Create the Branch Lines
	On the Project Navigator palette, right-click on the 01 Fire Protection construct and choose External References.
	In the “External References” dialog, right-click on 02 Framing, choose Detach — (see Figure 6.82).
	On the Home ribbon tab, on the Build panel, click Pipe.
	Click a point on the header approximately 4'-0" away from the wall at the left end of the building (the distance is not that important—we will move the pipe later).
	On the Properties palette, change the size to 2" and then pick a point toward the north side of the building just inside the wall.
	On the Annotate tab, on the Dimensions panel, click the Dimension, Linear tool.
	At the “first extension line origin” prompt, click a point on the inside face of the wall.
	At the “second extension line origin” prompt, click the end of the pipe using the pcon snap.
	Select the Pipe and then click the square grip at the midpoint.
	Move your cursor horizontally in the direction that it needs to move.
	Type in the distance that will bring you to 4'-0" and then press enter (see Figure 6.83).
	To verify your work, you can edit the dimension with grips to the new location. You can delete the dimension when you are finished.
	Select the tee that branches off the main, select the plus (+) grip, change the size to 2", and then route a pipe to the south wall of the building.

	Adding Sprinkler Heads
	Select the Branch Pipe at the northwest corner of the building, click the middle plus (+) grip, and then on the Properties palette in the Routing Options grouping (under Advanced) change the Branch fitting to: Takeoff only (see Figure 6.84).
	Set Nominal size to ½".
	Set Elevation to 8'-6".
	Press enter to exit the pipe command.
	Click in the right (Front) viewport to activate it.
	On the View tab, change to the Left view.
	Zoom in on the pipe you just added.
	On the Home tab, on the Build panel, click the Equipment tool.
	In the “Add Multi-view Parts” dialog that appears, expand the Mechanical folder, then the Fire Protection folder, and finally the Sprinklers folder.
	Select the Pendent Sprinkler – US Imperial item.
	At the bottom of the dialog, select the 0.5 Inch Pendent Sprinkler - Standard Coverage Standard Response from the “Part Size Name” list.
	In the Left viewport, place the part at the end of the vertical pipe you just drew. Press enter to accept the default rotation (see Figure 6.85).
	Close the “Add Multi-view Parts” dialog.
	Click in the left (Plan) viewport to activate it.
	In the Plan viewport, click above and to the left of the sprinkler and then click down and to the right to create a window selection.
	This will select the sprinkler, pipe and takeoff. On the ribbon, a Multiple Objects tab will appear.
	On the Home tab, click on the Modify panel title.
	The panel will expand to reveal several additional tools.
	Click the AEC Array tool (see the top left corner of Figure 6.86) (AEC Array is also available on the right click menu on selecting AEC Modify Tools.) You can also use the AutoCAD Array command to complete this step.
	At the “Select an edge to array” prompt, click on the main.
	A light blue line will appear on the main before you click to confirm selection (see the bottom left corner of Figure 6.86).
	Move the mouse out toward the upper outside wall.
	Type 8'-0" in the dynamic dimension on screen (it will appear near the midpoint of the main) and then press enter (see the middle of Figure 6.86).
	The squares will adjust and a tooltip will confirm the new spacing. To accept the array, click the mouse (see the right side of Figure 6.86).
	The objects have been arrayed along the pipe and automatically connected.
	On the Home tab, on the Modify panel, click the Copy tool (see Figure 6.87).
	Make a window selection (click from left to right) to surround all of the previously arrayed sprinklers and then press enter.
	Select a basepoint, move your cursor straight down towards the bottom of the screen, type 32'-0", and then press enter.
	This will copy the sprinklers to the other header.
	Window Select both branches. (Surround the entire branch to select the branches, the sprinkler heads, and fittings, including the tee at the main.)
	On the Home tab, click on the Modify panel title to expand it and then click the AEC Array tool.
	Click on the branch at the edge to array.
	Type 7'-9" and then press enter in the dynamic dimension
	Drag out the array across the building and then click to complete it (see Figure 6.88).
	When you have completed your layout, save and close all project files.

	Summary



